Remark Office OMR
Tutorials

Tutorial Overview

We want you to be immediately successful with your new software. To that end, we highly
recommend that you walk through the tutorials provided here before you do anything else with your
new software. The following sections contain the tutorials, which are designed to give you an
overview of the Remark Office OMR software and allow you to quickly learn the basic functions of the
software. Two of the most common uses for Remark Office OMR are surveys and tests; therefore we
have covered both form types in these tutorials. Completing these lessons will help position you for
mastering the software. Please keep in mind that even though you may only currently do one or the
other (surveys or tests), completing both tutorials will still help you understand basic software
premises. We recommend starting with Tutorial | and then continuing with Tutorial Il to get the
broadest knowledgebase (the first tutorial provides more detailed instruc tions and explanations than
the second tutorial).

9 Tutorial | 0 Test (Generic Test Answer Sheet): The first tutorial outlines how to create a
form template for a test and includes coverage of both basic and advanced options. The first
tutorial also covers reading tests and grading the test data.

9 Tutorial Il 0 Survey (Hospital Stay Evaluation): The second tutorial outlines how to create a
form template for a basic survey as well as read forms, correct the output and run reports.

Important Note: The tutorials provided with the software work with image Files that

are included when you install Remark Office OMR. In reality, the software can read
Pages directly from a scanner, or read scanned imageFiles from other sources, such as a
multi-function printer (MFP). Even though you are reading pre-scanned image Files, the
steps you are taking are very similar to scanning directly in the software. If you process
your own forms directly with a scanner, you choose the options to scan instead of read
from images within the software. The tutorials still give you a good overview of how the
software works in order to prepare you for using your own forms and scanner.

Please note that we have included copies of the tutorial forms in Microsoft Word format
for your reference. Each document installs to its corresponding tutorial folder, typically
in your My Documents folder under Remark Office OMR. These forms are not meant to
be scanned in order to perform the tutorials; images of pre -scanned forms are supplied
for this purpose. However, you may find it useful to view or print the forms before you
do the tutorials as reference.



The following information details what is accomplished in each tutorial:

Tutorial 1 6 Test

A Creating the test answer sheet form template
o Creating a barcode region
0o Creating an OCR region
0 Creating OMR regions

A Processing completed tests
A Reviewing and correcting data output with Review Exceptions
A Saving the test data

. I

Grading tests, including the use of bonus and subjective points
A Saving a grade report

Tutorial Il 8 Survey
A Creating the hospital stay evaluation form template
0 Creating an OCR region

o0 Creating OMR regions
0 Creating linked OMR regions

A Processing completed course evaluation forms

A Reviewing and correcting data output with Review Exceptions
A Savingthe hospital stay evaluation data

A Analyzing the hospital stay evaluation data

o Using Report Batches

There are some basic concepts to review before you get started with the tutorials. Please note that

there are several ways to access basic software functins. Three of the most common methods
include:

I Task Pane: The task pane on the left side of each Remark Office OMR window can be used to
access the most common functions in the software. The Task Pane automatically updates
based on the functions you perform. You can show or hide the task pane by selecting the
View menu and then clicking Task Pane.

1 Toolbar: The toolbar is the series of icons across the top of each Remark Office OMR
window. These icons represent shortcuts for common functions within the software.

1 Menus: The pull-down menus have all of the functions available within the software. Many of
these functions can also be found in the toolbar and task pane.

It is up to you to decide how you wish to access software functions. We will work with all thre e
methods to allow you an understanding of each method.

Before we begin, we need to touch briefly on some important concepts that may be new to you. Just
take in the big picture for now; details will be built as these concepts are used in the lessons.



Form Template Overview

The foll owing concepts are explained in greater det ai
important to understand in performing these tutorials. Here is a quick overview to help you get
started:

What is a Form Template File?

The first thing you do in Remark Office OMR (after you have a form created outside the software) is
create form templates for the forms you wish to process in the software. A form template File contains
the information needed to instruct Remark Office OMR about each form. The form template conveys
the location of the information on the Pages (e.g., the bubbles the respondents darken) and the
specifics of the data you require. The form template defines the backend database you use for
storage of the pro cessed data. You create a form template for each form that you wish to process
using the software.

How are Form Templates Created?

Form templates are created by scanning an unmarked copy of the form (or importing a scanned
image of the blank form) to create an equivalent image in the Remark Office OMR Template Editor.
You then use the mouse to drag boxes (called regions) around the marks (e.g., bubbles) and other
areas you want to have recognized on your form. These regions tell the software where each piee of
information you want to capture is located on the Pageand other pertinent information about the
form. They also tell the software what type of data you need the software to output from each area.

You are now ready to get started with the tutorials .



Tutorial | 0 The Test Answer Sheet

The Test Answer Sheet tutorial is designed to provide you with experience in the basic and a few
advanced functions of creating a form template and processing forms. The following procedures
describe how to set up a form template for the sample Test Answer Sheet form included with the
software. Subsequent sections of this tutorial detail how to process forms and export or analyze the
data.

The form template creation process consists of:

1 Scanning an unmaked copy of the form (or importing an image of a previously scanned copy
of the form)

1 Dragging boxes around the areas to be recognized
1 Providing Remark Office OMR with information about the data you need to collect

Important Note: As stated previously in the tutorial overview, the tutorials provided with the
software work with image Files that are included when you install Remark Office OMR. Even
though you will be reading pre -scanned image Files, the steps you are taking are very similar to
scanning directly in the software. The tutorials still give you a good overview of how the
software works in order to prepare you for using your own forms and scanner.

Creating the Form Template

The first step in this process is to create a form template outlining the areas on the form that you
want the software to recognize.

To begin the Test Answer Sheet form template

1. If not already running, start Remark Office OMR (Sart|Programs|Remark Office OMRRemark
Office OMR Data Center).

2. Begin a new form template. Select the File menu and then click New Form Template .
Alternatively, in the left-hand panel, known as the Task Pane, selectNew from the Templates
tab. Any of these actions will open a second window containing the Remark Office OMR
Template Editor .

Tip: If you use File|New Form Template or the New link in the Task Pane, the
Template Editor opens with the new form template window already opened for you.

3. [Optional] If the Template Editor opens but you do not see the Properties - Form Template
(New) window, select the File menu and then click New Form Template .

The Properties - Form Template (New) window opens. This window is where you describe your form
to Remark Office OMR. You do this by entering basic information about your form, including the form
template description, Pagesize and Page orientation.

4. Enter Test Answer Sheet in the Description box.



5. Locate the Page size area where you can tell the
software the size paper your form uses.If not
already selected, ®lect US Letter in the Size
drop-down list.

6. Locatethe Page orientation area and select
Portrait .

7. Click the Capture Image button to continue.
The Create Page Elements window appears. The

Create Page Elements window allows you to either
acquire an image of your form from your scanner, or

Properties - Form Template (New)

Describe and define the layout of your new form template,
O Acquire page images
O All pages must be of the same size
O Al pages must conform to the same page orientation

Description [optional): | Test Answer Sheet

Page size: US Letter -
Unit of measure: Inches -

Page orientation: Fortrait -

Capture Image...

Cancel

acquire an image of your form from an existing image File. EachPagein a form template is created
using an image of the appropriate Pagein your form. The image allows you to see the form so that

you can easily teach Remark Office OMR how to read it.

To obtain a form template image

As previously mentioned, there are two ways to acquire an image for a form template Page Images
can be acquired by scanning to create a new imageFile or by opening an existing image File. We will
be acquiring our image from a pre -scanned image File stored on your computer.

1. Click the button for Read Images in the Image
Collection Method area.

2. Click the Browse button. The Select Image File
window opens.

3. Select the Tutorial 1 & Test Answer Sheet .tif File

from the Tutorial 1 folder of your R emark Office
OMR installation directory (e.g. \My

Documents\Remark Office OMR Tutorials\ Tutorial

1) and then click the Open button .

Once an image is acquired by opening an existing

Create Page Elements

- r-
s Read Images

Browse
Page Drop-out Colors (Applies To Color Images)
Dges | ——
Oe | E—
Oa E—
Drop-outthresnols: 20 2]

Images Should Be Unmarked (Not Filled Out) ‘ Too Few Pages (1 Page Required)

image File, the Template Editor displays a thumbnail of the image for your approval.

4. When a thumbnail image of your form appears, click the OK button to accept the image.

Once the thumbnail image is accepted, the Template Editor opens the new form template where you
can begin to define the regions. You see a tree view (item lisf) on the left and an image representation

of your form on the right.

To define form template regions

The purpose behind making a form template is to tell the software where to locate the information on
your specific form and how to understand your spe cific data requirements. The following table lists
the six regions on the Test Answer Sheet form and their corresponding region types:




Area on Form Corresponding Region Type

Student Name OCR

Teacher Name Barcode
Questions 1-50 (2 regions) OMR (Multiple)
Bonus Question OMR (Multiple)
Official Use Only (used as subjective region) OMR (Grid)

To define the Student Name as an OCR region

The first area of the form to define is the Student Name, which is defined as an OCR (optical character
recognition) region. OCR involves reading computergenerated text (not handwriting). In this case, the
test answer sheets were printed with each studentds r

Using OCR allows you to quickly ctisinfermdtionerach st udent
subsequent grade reports.

1. Highlight the Page 1 node on the left side of your screen, if it is not already highlighted.

Select the Page menu, click Insert and then click OCR Region After Selected Page, or click the
OCRtoolbar button to insert an OCR region. Alternatively, select theDefine regions link in the
task pane and then selectinsert OCR region .

The mouse changes to a crosshair.

3. To create the OCR region, place the cursor just beyond the top left of the text, then press and
hold the left mouse button while dragging the rectangle beyond the bottom right corner of the
text, making sure you have selected the entire allotted space.For OCR areas, capture a little extra
space at the end of the text to accommodate the largest amount of text you might process
(student names will vary in length).
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4. After positioning the box, release the mouse button and the Properties window appears to allow
you to define the regionds properties. This window
about the text.

Tip: You can use your cursor to drag/slide the Properties box on your screen if you
need to see anything on your form. Do not worry if the region is not drawn perfectly at
this point because you can easily adjust it by dragging the borders as needed after the
regionds propert i ePsopetticsewindl@viclosesed and t he

5. Type Student Name in the Region name box. The Region name provides a brief description of
the region and becomes the name for this column in your data set.



6. Setthe OCR type to Primary . Primary OCR works well in most cases and is the default setting.
(Microsoft Office Document Imaging is a second OCR option available if you have Microsoft
Office 2007 or later installed on your computer. o SR T T— L. ™
Legacy OCR refers to an older OR engine that e OCR Region Definition and Deta

Region Definition

was used in the software previously.) Advanced Region Properte: SN

OCR type: Primary -

7. The following options should be set to their
default settings:

Data type: Textual -

Language: English, Middle -

Text orientation: | Left to Right hd

1 Data Type is Textual . We are collecting
student names, which are textual. If we were to
export our data once it is collected, the data
type would be flagged as textual in the output
File. When creating your own form templates,
the data type you select can be textual or
numeric, depending on the type of data you
require.

1 Language is English, Middle .
9 Orientation to Left to Right . The text on our form is oriented from left to right
1 OCRImage Pre-Process Options are all unchecked.

8. Mark the checkbox for Region contains more than one word . This region contains both a first
and last name for each student.

9. Click the Advanced Region Properties link in the Task Pane to the left.

10. In the area called Analysis Respondent ID , mark the checkbox for Designate as a respondent
ID. When you run reports in Remark Quick Stats, any regions marked as Analysis Respondent IDs
appear on select reports to identify each respondent. This way you can run student grade reports
with the studentsd names on them to hand back to t

11. Click the OK button to return to the main Template Editor window.

You now see a purple box around the text in the image area, identifying it as an OCR region, and a
new node in the tree view titled Student Name .

To define the Teacher Name as a Barcode region

The Teacher Name is defined as a barcode region. Using a barcode allows you to quickly collect each
t eacher 6s n agethis afarchatidn loresnbsaguent grade reports. In our case, we will filter
our data by teacher to evaluate teacher performance.

1. Highlight the Student Name node on the left side of your screen if it is not already highlighted.

2. Select the REGIONmenu, click Insert and then click Barcode Region After Selected Page, or
click the barcode toolbar button to insert a Barcode region. Alternatively, select the Define
regions link in the task pane and then select Insert Barcode region .

The mouse changes to a crossair.

3. Tocreate the Barcode region, place the cursor just beyond the top left of the barcode, then press
and hold the left mouse button while dragging the rectangle beyond the bottom right corner of
the barcode, making sure you have selected the entire albtted space. For barcodes, capture a



little extra space at the end of the barcode to accommodate the largest possible barcode you
might process. It is okay to encapsulate the text beneath the barcode since it is small.

4. After positioning the box, re lease the mouse button and the Properties - Barcode Region
window appears, allowing you to define the regionds
provide pertinent information about the barcode.

Properties - Barcods Region (Teacher Name]
e

5. Type Teacher Name in the Region name box.
The Region name provides a brief description of
the region and becomes the name for this column
in your data set.

6. Setthe Barcode type to Code 39 and the
Barcode orientation to Horizontal . These
settings allow you to specify the barcode type to
recognized and/or positioning of the barcode on
your form.

Barcode Region Definition Barcode Region Definition and Deta
. Region Definition

Region Properties

Region pame: Teacher Name

Barcode type: Code 39 - Detect...
Barcode orientation: Horizontal v o

Data type: Textual -

[ Barcode Contains Multiple Items

I

Include region in read operation

7. Setthe Data Type to Textual . We are collecting
teacher names, which are textual. If we were to
export our data once it is collected, the data type
would be flagged as textual in the output File.

8. Click the OK button to return to the main
Template Editor window.

You now see an orange box around the barcode in the image area, identifying it as a Barcode region,
and a new node in the tree view titled Teacher Name.

To define the test questions as OMR regions

The 50 test questions are broken into two sections, each containing 25 questions. You create an OMR
region for the first 25 questions and then copy and paste that region to the other set of 25 questions.

Tip: When creating similar regions, using copy and paste can savetime. Once you paste
a region, you can access its properties to make any changes. However, by copying
similar regions, you save time in entering all of the region information.

1. Highlightthe Teacher Name node in the left side of your screen if it is not al ready
highlighted.



2. Click the OMR toolbar button to insert an OMR region, and use the crosshair to draw a box
around the first set of 25 questions, begi
(question 1) and ending at the bottom right forthel ast OEO6 bubbl e (que

Tip: When defining an OMR region, include only the actual marks; never include the
nearby labels, text, etc. Also, create approximately a 1/8 inch buffer space between the
marks and the edge of the defined region. This buffer allows Remark Office OMR to
accommodate minor shifting or skewing during form processing and decrease the
number of data exceptions you need to clean in the resulting data.

- GOEEPNEREEEREREBEE
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After positioning the box, release the mouse button. The Properties 8 OMR Region window
appears, allowing you to enter information that will define the OMR region and the data it
produces, including:

1 Region Definition (the area containing Region name , the type of OMR region or OMR type
and the Data type ).

1 Region Layout of the region (the area detailing how many Rows and Columns of marks are
contained in the region and their orientation).

1 Possible Responses (the Labels you want to see as your data).
3. Enter Question in the Region name box. We call the two regions containing the 50 questions
OQuestion. o6 Your region names then become Questionl
4. SelectMultiple asthe OMR type . The Multiple region designation is used for typical multiple
choice style questions.

Note: There areother types of OMR regions that can be seenif you click the down
arrow to the right of Multiple . These additional region types offer differing types of
data output. The additional OMR region types are explained in your Remark Office OMR
userds gui de.

5. SelectTextual for the Data type . This region contains the answer choices AE, so textual data is
appropriate.

Broperties - OMR Region

6. Inthe Region Layout area, selectRow for the R e
Region orientation because each question fehenced fegion ropertes
occupies one row.

Region

n Properties OMRiype  |Murtiple

Datatype:  Textual

7. Ensurethat 5 was entered in the Columns in the
region box and 25 in the Rows in the r egion
box. The 5 columns represent our answer choices
(A-E) and the 25 rows represent our 25 different
guestions.

8. Use the Possible label scales drop-down list to
select A-E These labels automatically fill the
Labels grid. Your choice of Labels in the form
template determines what you see in the data set
when your filled in forms are processed. The
Labels represent the response choices for each bubble, moving from top to bottom. You notice
that each Label automatically has a value in theValues column to th e right. While the Labels
represent the data you see returned from the processed forms, the Values represent the
information Remark Office OMR uses to perform any statistical analysis (these values are not
grading point assignments).

9. Click the OK button to return to the main Template Editor window.

9



You now see a green box around questions 1-25 in the image area, identifying them as an OMR
region, and a new node in the tree view titled Question .

To copy and paste the Question OMR region

Next, copy the region you just created and paste it over the remaining 25 questions. Copying similar
guestions saves time in the template creation process.

1. with the Question node highlighted in the tree view, select the Edit menu and then click Copy.
2. Select the Edit menu and then click Paste.

Tip: You can use the keyboard shortcut keys forCopy (Ctrl + C) and Paste (Ctrl + V)
for quick copying and pasting.

A red region is drawn near questions 1-25.

[ - ¢ H

3. Place the mouse directly over the red region
until it becomes two doubl e arrows and then
drag the new region to questions 26 -50,
positioning it directly over the 25 questions.

4. Release the mouse. Check your positioning;
if the solid red color disappears, this is an
indication that you have moved the box
successfully. If the egion is still red, hover
your mouse over it to see text describing
where the problem lies.

You should now have two OMR regions, one covering each of the groups of 25 questions, and two
nodes in the tree view titled Question (1 -25), Question (26 -50).

To create the bonus question OMR region

The question at the bottom of the exam answer sheet that reads Bonus is used to add extra credit
points to the overall test score.

1. Highlight the Question (26 -50) node in the tree
view, if it is not already highlighted .

2. Click the OMR toolbar button to insert an OMR
region, and use the crosshair to draw a box around
the bonus questh)onds bub

: [Muttiple - e

Datatype: | Textual -

3. When the Properties 8 OMR Region box opens,
enter Bonus in the Region name box.

4. SelectMultiple asthe OMR type . Thisis a multiple-
choice question.

5. SelectTextual for the Data type . This region
contains the answer choices AE, so textual data is
appropriate.

o
0

10



6. Inthe Region Layout area, selectRow for the Region orientation because the question is

oriented in one row.

7. Enter 5 inthe Columns in the region box and 1 in the Rows in the region box. The 5 columns
represent our answer choices (AE) and the 1 row represents our single bonus questions.

8. Use the Possible label scales drop-down list to
select A-E. These labels autormatically fill the Labels
grid. The Labels represent the data output you see
when you process forms. Corresponding values are
automatically entered in the Values grid. These
Values are used for statistical analysis (these values
are not grading point assign ments).

9. Click the Advanced Region Properties link in the
Task Pane to the left.

10. In the area called TestingPoint System , change the
number set for Correct points to 5. When the tests
are graded, if the student gets the bonus question
right, they will be rewarded 5 extra credit points.

11. Mark the checkbox for Treat awarded points as

Properties - GMR Region [Bonus

Advanced Region Properties

Test Settings
O Do not grade this item

© Grade this item

O Designate as test version ID

Advanced Region Properties

® Tabulate this item

Question Properties

~|  Coredt points:

Incorrect points:

Mo response points:

[m] Threshold yalue

Replace with: |BLANK [BLANK] ~

Flag blanks: | Always =

[ Disable mark discrimination

[ Regquired item

Treat awarded points as extra credif

Recognition Threshold For Region

=
5000 =5
=
0000 ]

=
0.000 5]

ALy |~

(3

extra credit . When grading, whether using Quick Grade or Advanced Grade, this question is

considered extra credit.

12. Click the OK button to return to the main Template Editor window .

You now see a green box around the Bonus question in the image area, identifying it as an OMR

region, and a new node in the tree view titled Bonus.

To create the Official Use Only OMR region

The Official Use Only area allows a teacher to bubble in ponts awarded for a subjective question on

the test. Subjective questions could be essays, short answer questions, etc. This type of question has

to be graded by a person, but you can add the points earned to the total test score by designating it

as a subjective question.

1. Highlight the Bonus node in the tree view, if it is not already highlighted.

2. Click the OMR toolbar button to insert an OMR region, and use the crosshair to draw a box

around the entire set of bubbles in the Official Use Only area questiond s

bub-B)l es

(0

3. When the Properties 8 OMR Region box opens, enter Subjective in the Region name box. We
title it Subjective in order to remember that this question is for designating our subjective points
for the human -graded part of the test.

4. SelectGrid as the OMR type . Grid regions capture information that spans across multiple rows

and columns, but consists of a single piece of data (e.g., zip codes, names, social security
numbers, phone numbers, etc.). In our case, the teacher bubbles in a twadigit number
representing the points earned on the subjective portion of the test.

11




SelectNumeric for the Data type . This region
contains a two-digit number, so numeric data is
appropriate.

In the Region Layout area, selectRow for the
Region orientation because the question is
oriented by row (each row is one digit in the two -
digit number).

Enter 10 in the Columns in the region box and 2
in the Rows in the region box. The 10 columns
represent our answer choices (39) and the 2
rows represent the digits in the subjective score.

Use the Possible label scales drop-down list to
select 0-9. These labels automatically fill the
Labels grid. The Labels represent the data output
you see when you process forms.

Click the Advanced Region Properties link in
the Task Pare to the left.

Under Test Settings , mark the option for Grade
this item .

In the Testing Point System area, under Item
Test Type, selectSubjective item . For
Subjective points , enter 20.

Click the OK button to return to the main
Template Editor window.

Properties - OMR Region [Subjective]

OMR Region Definition
Advanced Region Properties

fon Properties

Data type:

Saye Current Scale

OMR Region Definition and Deta
Region Definition
Region name: Subjective

OMRtype:  |Grid

Humeric

Response Chaices

Possible label scales:

[ Define Format (Grid Type Only)

Include region in read operation

Region Layout
Region orientation: | Row 2
Columns in the region: 10
- Rows in the region: 2

[ Read bottom-to-top

e W e

~| Labels j

oK Cancel

OMR Region Definition

Advanced Region Properties

Question Properties

m]

Replace with:

Flag orid blanks: AlWays

Advanced Region Properties

Test Settings
O Do not grade this item

@ Grade this item

© Designate as test version ID

Testing Point System
Ttem test type: |Subjective item

Subjective items usually consist of short
answer, essay, of ather non-seannable ftems.

Analysis Respondent ID

Blank Response Exceptions

L] Disable mark discrimination

[ Reguired item

Nothing [ -

Survey Settings
® Do not tabylate this item
O Tabulate this item

" . =1
Subjective points: w000 [

] Treat awarded points as extra credit

Recognition Thresheld For Region

. =
Threshald value 3y

Multiple Response Exceptions
Multiple responses; Mot allowed -

Replace with: Asterisk [1] -

oK Cancel

You see a green box around the Official Use Only question in the image area, identifying it as an
OMR region, and a new node in the tree view titled Subjective .

To save the Tutorial 1 form template

We are finished creating all of the regions in our form te mplate and need to save the form template
as aFilewe can use to process completed forms.

2.

Select the File menu and then click Save Data. Alternatively, select the Save Data link in the Task
Pane. Make note of where you save the form template File (we suggest in\My
Documents\Remark Office OMR Tutorials\ Tutorial 1, but not overwriting the tutorial File that we

supply in case you need it later).

In the File name box, type Tutoriall and then click the Save button.

You have now created the Tutorial 1 form template. Close the Template Editor by selecting the File
menu and then clicking Exit. Alternatively, you may also simply click the X in the upper right hand
corner of the Template Editor window.

12




Processing the Completed Answer Sheets

Now that you have created the form template for the Test Answer Sheet you are ready to begin
processing the completed forms using the supplied image Files.

To open the Test Answer Sheet form template

1. If not already running, start the Remark Office OMR Data Center (Start|Programs|Remak Office
OMR]|Remark Office OMR Data Center). When théData Center opens, it displays a blank
spreadsheetstyle data grid.

2. Select the File menu and then click Open Form Template . Alternatively, select the Open Other
Templates link in the Task Pane. You musopen a form template in order to process forms.

Tip: When you are in the Remark Office OMR Template Editor with a form template
open, you can selectFile]Launch Remark Office OMR and the Data Center opens with
the selected form template also open.

3. Selectthe Tutoriall.omr File you created in the previous section of this tutorial and then click the
Open button. Alternatively, we have provided a sample Filein \My Documents\Remark Office
OMR\Tutorials\Tutorial 1\Remark Office OMR Tutorial 160 Sample Test.onr.

When the Tutoriall form template opens, its name appears on the title bar at the top of the screen

and you see the region names you specified as your column headers in the data grid. Each column in
the grid corresponds with one variable or question in t he form template, as the column headers
indicate. The data grid fills row by row as your completed forms are processed. Each grid row contains
information from one processed form regardless of the number of Pages the form contains.

To read from image Files

The Read window is used to process completed forms and produce data. The Readvindow has
several steps to help customize the reading process. This tutorial focuses on the basic functions. As
stated previously, we are reading pre-scanned image Files.

1. Sdect the Tools menu and then click Read. offe Pegd - Aeod gaeries G . . _N —

How would you like to collect your data?
Alternatively, you may select the Read link from the task
Read Jmages

Click Mext to browse for image files to read,

pane or Read button on the toolbar.

2. Select the Read Images button if it is not already
selected.

3. Click the Next button to continue.

The Image Selection window appears to enable you to
view and select the images you want to process.

4. Navigate to the Tutorial 1 folder of your Remark Office
OMR installation (e.g.\My Documents\Remark Office
OMR\Tutorials\Tutorial 1).

o
7
EY
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5. Navigate to the Images for Processing folder.

6. Select theFiles called Tutorial 1 d Answer T

Key.tif and Tutorial 1 & Completed Test [ e o P Jetr e LiE-O

Forms.tif by either double clicking them or B Tutoralt - Answer Key it s
selecting them and clicking the Add Selected, || = freerrem " saasiedes
which moves them into the Images in Read
Order window on the right. You may also click
Add All button to move any images in the
folder to the Images List (in Read Order)
window. Note that the first Filein the list is the
answer key for the test. The secondFileis a
multi - Page TIF imageFile that contains 20

student tests.

Image Files [*pog*tif, . pdf,*.bmp;*.dox . Jpg;*jpeg; . png;* tiff) -

Image List {In Read Order) + E

Tip: You can use the Ctrl or Shift keys to
select multiple image Files and then use the
Add Selected Images button to move the
images to the Images in Read Order
window.

Cancel £ Back

7. Click the Next button to continue.

The Review Exceptions window appears. This window allows you to configure options for reviewing
exception cases such as blank and multiple responses. We will not be using this feature in this tutorial.

8. If the Enable Review Exceptions button is selected, clickit to deselect this option. We are not
reviewing exceptions at this time.

9. Click the Read button to begin reading the image Files.

As each image is processed, you see a row added to the data grid.

Reviewing and Correcting the Data

After the forms are processed, 21 rows of data are displayed in the data grid. Eab row represents the
responses collected from one of the forms. The first row is the answer key for the test, and the
following rows are student tests. You are now ready to inspect the data for missing or unrecognized
responses in order to prepare for analysis and/or data export.

How does the software handle data exceptions?

Remark Office OMR informs you of unrecognized or questionable responses by placing a visible
marker in each appropriate data grid cell. Each one of the types of problematic or potent ially
inaccurate data is represented by a specific color and explanatory text (e.g., yellow color and the word
BLANK). TheExceptions Legend in the Task Pane provides an easy reference key to the nine possible
exception cases and their meanings.

The software then assists you to correct exception cases or problems by allowing you to see what was

entered on the actual form. The stored images for each processed form are available to display your
respondent s® answer choi ces.edatagdtc\wew thedorrespindingn si de an\
image of that form. (If you click in a cell and do not see an image beneath the data grid, select the

View menu and then click Image Viewer to open the Image Viewer.)
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To run Review Exceptions
We use an automated tool called Review Exceptions to locate and correct any exceptions in our data.

1. Click the Tools menu and then select Review Exceptions, or click the Review Exceptions link in
the Task Pane.

2. Once you access Review Exceptions, use the task pane to select the excépn cases you would
like to review: Blank responses, Multiple Responses, Recognition Errors, Image Regions, Database
Lookup Regions, Barcode Regions, OCR Regions, Repeated Rank Responses or Required Items.
You can also choose whether to search by rows orcolumns in the data grid.

3. Click the NEXT button at the top of the data grid to start the review process.

The Data Center searches the data for the specified exception cases. When a selected exception case
is found, it appears in the data header bar at the top of the data grid. The bar is color coded to match
the exception type (e.g., yellow for a BLANK response). Use this window to make changes. You can
use the drop-down list if applicable, or type a response. Note if there is a list of answer choices
defined, as you begin typing, Remark Office OMR will attempt to auto-fill your answer based on your
possible answer choices.

3. The first piece of flagged data is a
multiple response in the eighth grid row
for the item called Question8 . In the data

header bar use the drop-down list to
select the appropriate response. Use the
Image Viewer beneath the data grid to
review the student 0sj
you see the student accidentally marked A
and then put an X through it. The

intended response was B. SelecB from
the drop-down list. You may also simply
type B.

4. PressEnter or click the NEXT button to continue.

5. The next exception is a multiple response in row 16 for question 12. Look at the Image Viewer to
see the intended response. In this case, the student marke& both D and E, but crossed out E. Use
the drop-down list in the Review Exceptions pane to selectD from the list (or type D).

6. Press Enter or click theNEXT button to continue.

7. The next exception is a blank response in row 17 for question 6. Look at the Image Viewer to see
the intended responses. In this case, the student truly left the question blank. You may simply
press Enter to ignore it. The question will be marked as incorrect when the data are scored.

8. Press Enter or click theNEXT button to continue.

9. All exceptions have been cleaned and you are prompted to save the changes. Click theSave
Changes button to save your changes.

Your data set is now ready to be saved and analyzed.
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Saving the Test Data

Remark Office OMR provides manyFile formats for exporting data to other applications. For this
tutorial, the data set is saved to the Remark Extended (RMX) format, which is a proprietary format
within the software. This format saves the exception colors (if any are present) as well as the link from
the data to the stored images so that you can open your data and still view the image that
corresponds with any piece of data.

To save the exam data
1. Select the File menu and then click Save Data, or click Save Data in the Task Pane

2. Data can be saved anywhere m your system. By default, a Data folder is installed in the Remark
Office OMR directory; we recommend using this folder for storage of data Files. In the Look in
box, navigate to this Data folder on your system (e.g. \My Documents\Remark Office OMRData).

Click the Save as type down arrow to display a list of Filetypes.

If not already selected, click the Remark Extended (.RMX) format.
Type Tutoriall in the box titled File name.

Click the OK button to save the File.

oo s W

Grading the Test Data

Remark Office OMR provides statistical analysis functionality for grading data from your tests. There
are two ways to grade an exam:

Quick Grade: Uses the first grid row as the answer key by default as well as all settings defined in the
form template (e.g., whether a question is graded, assigned point values and respondent identifiers).

Advanced Grade: Allows you to customize the grading process, including adding benchmark values,
customized grade scales and learning objectives (subtests).

For this tutorial, we will demon strate Advanced Grade.

Tip: The Remark Quick Stats module of the software includes various ways to

tabul ate/ grade data and display reports. Review t
PDFFile by clicking Start|Programs|Remark Office OMR|Documentation  to see all

available analysis features.

To grade the exam data

1. Select the Tools menu, click Analysis and then click Advanced Grade, or select the Analysis tab
in the Task Pane and then clickthe Advanced Grade link.

The Basic Test Optionswindow appears.
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2. Mark the checkbox for Use a test benchmark ,
choose Custom and enter the number 75. A
Benchmark is a target score you want your
students to achieve. Reports that include
benchmarks show you which students achieved
the benchmark percent, which did not and the
difference between the
benchmark. Using Benchmarks is useful for
seeing how well your students are mastering
topics.

3. Click the Answer Key link in the TaskPaneto
continue.

The Answer Key window appears. This window is
where you specify an answer key. You may scan a
key, import a key from an image File, use a grid row
as the key or type an answer key. In our case, we
processed the answer key as the first row of our
data grid.

4. In the Import answer key from box, use the
drop-down arrow to select Data Set (Grid)
Row. By default, the grid row box is filled with
the number 1.

5. Click the Import Key button to obtain the
answer key responses from the data grid.

6. Click the Question Properties link in the Task
Paneto continue.

wer key file:

Open an existing answer key file if you would like to preload the advanced grade settings based on a previously saved configuration,

Overall test gra

le: Edit Grade Scale...

Use a test benchmark: | Custom - 7500 2ls,

] Use custom report hesders

Top-Left report header.

Top-Center report header:

Top-Right report header:

Querall test scaled score:

Edit Scaled Score,

F Correct Answer

MRS, WILSON

A
B
c
D
E
[
c
3

Data Set (Grid) Row - 12

Import Key.

Grade As Objective

X KK FKMKEE R K X

Grade As smmj

Grade None

7. The Question Pro perties window appears. This window allows you to change properties you
defined in the form template for this grading session. You may change things such as respondent
identifiers, point values, correct answers, data type and question text. You may also ad a

benchmark value for individual questions. Changes made here do not change the form template.

You may hold down the Shift or Ctrl keys and select multiple questions to make the same change
to each question. For the purposes of this tutorial, we set up everything correctly in the form
template, so we do not need to make any adjustments to this window.

8. Click the Learning Objectives link in the Task Paneto continue.

The Learning Objectives window appears. This window is where you define learning objectives

(sometimes called subtests). You may assign questions to each learning objective you define so that

the software provides a separate grade for that subset of questions. This feature allows you to track
progress on specific objectives that you are teaching your students. For this tutorial, we are defining

two learning objectives.

9. Click the New button.
10. In the Objective name , enter Spelling .

11. Mark the Use benchmark box, select Customand enter 75. Using a benchmark score indicates
that your students need to score at least 75% on this learning to be considered proficient at

spelling.
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12. Click the New button.

13. Enter Grammar in the Objective n ame box. The same benchmark value of 75 is prefilled for you.

You should now have two learning objectives defined: Spelling and Grammar . The next step is to

pick the questions that belong to each Learning
Objective.

14. Highlight Spelling in the Learning objectives
column.

15. In the Available questions column, click
Questionl . Hold down the Shift key and then
click Question10 . Questionl through
Question10 are selected.

16. Click the Align Questions button. The
guestions appear under Spelling in the
Learning objectives column.

17. Highlight Grammar in the Learning
objectives column.

Advanced Grade

Learning Objectives

Test Versions

=3

New Import..
Objective Properties
Objective name: Spelling

Desaription: =
=

Edit Scaled Score..

[ Use benchmarkz |Custom - 7500 (25

Leaming objectives: Agaiable questions: Az

53— Questiontl

fspetiing Question2s
Questiont Question12

Question3g
Question2s
Question27
Question2s
Question29
Question30
Question3t
Question32

Questiondo
Questiond1
Questiond2
Questiond3
Questiond4
Questionds
Questionds

Question13
Question2 Question14
Questionts
Questionts
Question1?
Question1s

Question3
Questiond
Questions
Questions
Question?
Quetions
Questiond
Question10
. Grammar

Remoye Questions Align Questions

@k Tip! In addition to double-clicking and using the buttons, you can also drag and drop questions onto objectives.

B soe - Grade Cancel

18. In the Available questions column, click Question11 , hold down Shift and then click

Question20 . Questionl11 through Question20 are selected.

19. Click the Align Questions button. The questions appear under Grammar in the Learning

objectives column.

20. We are finished setting up the answer key, so click theGrade button.

You are prompted to save the answer key. Saving answer keys is useful if you administer the same test

on multiple occasions.
21. Click the Yes button to save the answer key.

22. In the Save Answer Key window, type Tutoriall in the File name box.

23. Click the Save butto n to save the File. You receive a confirmation notice that the File was saved

and then Remark Quick Stats opens.
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Reviewing Grade Results and Reports

Once Remark Quick Stats opens, you have access to a variety of grade reports. You can reportrothe
test itself, the class or individual students. For this tutorial, we will look at the Student Statistics,
Student Response and Student Grade Reports.

To run the Student Statistics Report

1. By default, the Student Statistics report displays automaticaly. If you are not seeing this report,
select the Student Statistics Report link in the list of reports under Class and Student Reports .

s i

The Student Statistics Report displays the
grades for the entire class. Each student can
optionally be identified by an Analysis
Respondent ID region (chosen in the form
template or Advanced Grade) if desired. In this
tutorial, we designated the Student ID barcode
as an Analysis Respondent ID. You can also
view the benchmark information and learning
objectives. This repat provides a nice overview .
of how your class is performing. Use the Page
Navigation Tools at the top of the window to
review the various Pages of your report.

2. To gain some comfort with the Remark Quick Stats window, go to the toolbar and use the Full
Screen button to expand the report. Then toggle back to the default view by selecting the button
again. If you need to, use the Zoom In and Zoom Out buttons to increase or decrease the size of
the report image.

Next, we will look at the Student ResponseReport.

To run the Student Response Report

The Student Response Report allows you to
view class and question performance, along
with score data in a graphical format. =3

1. Inthe Task Pane under Class and Student
Reports, select the Student Response
Report link.

The report displays each question across the
top and each student down the left. Green
indicates the question was answered correctly,
red indicates the question was answered incorrectly and white indicates the question was left blank.

Means are included at the bottom of each column. Use the Navigation Tools at the top of the window

to scroll to the second Page, where you find summary score information. Report colors are

customi zabl e in the reportds options, | ocwindeewd i n the
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Finally, we will look at the Student Grade Report.

Respondent Selection - Student Grade Report

To run the Student Grade Report

Select the respandents you would like to use in this report.

1. Inthe Task Pane under Class and Student Reports, select the
Student Grade Report link.

2. Select one or more students from the Respondents list and
click the Add button to move them to the Selected
respondents list. Alternatively, click the Add All button to
move all students over.

Respondents; v

Jonathan Finkel

3. Click the Run Report button; the report displays on the right.

The Student Grade Report shows an individual report of each
st ud e rade$. ¥ou gan show the correct and incorrect
responses, as well as an image of the actual test as it was scanned. o

You can also add customized headings such as high, low and mean
scores for the class. Learning objectives are tracked, as well as aem

i AddAll

subjective and extra credit points.

Exporting the Student Grade Reports

Once you have tabulated your data, you can save a report and/or export the report to one or more
formats for either storing or sharing with others. For this tutorial, we will export the Student G rade
Reports to PDFFiles. Saving to this format allows you to email test grades to parents, for example.

To export the Student Grade Reports

1. Select theFile menu, click Export and then click | Export Report

Report, or click the Export Report link in the
Task Pane.

2. Inthe Export Report box, selectPortable
Document Format (PDF) .

3. Inthe Pages area, selectAll.

4. Setthelmage quality to its default value of
High .

5. Click the Export button to choose a location
and File name for the PDFFile.

6. Inthe Save Aswindow, use the Look in drop-
down list to locate a folder on your computer
for the File. For this tutorial, use My

Export format: {Portable Document Format (PDF)

Pages: All -

Image guality: |High -

Export

Cancel

Documents or another folder where you can easily access the exported report.

7. Click the Save button to export the report.

You may now go to the My Documents fo Ider on your computer and view the resulting PDF Files.
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You have completed the first tutorial. Look below for a summary, and then continue on to Tutorial 2
for more practice.

Tutorial 1 Summary

The first tutorial illustrated basic and some advanced features of the software, including:
1 Creating a form template

0 Setting advanced region options
Processing forms
Using Review Exceptions to clean data
Saving data

Grading tests with Advanced Grade

=A =/ =4 =4 -4

Exporting reports
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Tutorial Il 6 The Hospital St ay Survey

The second tutorial quickly teaches you how to use the basic software functions and how to easily

navigate the softwareos

user interface. You

This evaluation is a typical survey form cantaining several types of areas that Remark Office OMR
recognizes, including text, OMR bubbles and an area for gathering comments. The survey asks
previous hospital patients to provide details about when and where they stayed and then answer

some basic questions to evaluate their stay. A survey such as this one can be scanned to produce data

and subsequently, reports to show how the hospital is performing.

You will perform the following steps in this tutorial:

Create the Hospital Stay Evaluation form templae

Process completed Hospital Stay Evaluation forms

Al

l

1 Review and correct the data output

1 Save the Hospital Stay Evaluation data
l

Analyze the Hospital Stay Evaluation data with Remark Quick Stats

Creating the Hospital Stay Evaluation Form Template

The first step in this process is to create a form template outlining the areas on the form that you

want the software to recognize.

1. If not already running, start Remark Office OMR (Start|Programs|Remark Office OMRRemark

Office OMR Data Center).

2. Begin a new form template. Select the File menu and then click New Form Template .
Alternatively, in the left-hand panel, known as the Task Pane, selectNew under the Templates
tab. Any of these actions will open a second window containing the Remark Office OMR

Template Editor .

Tip: If you use File|New Form Template or the New link in the Task Pane, the
Template Editor opens with the new form template window already opened for you.

3. [Optional] If the Template Editor opens but you do not see the Properties - Form Template

(New) window, select the File menu and
then click New Form Template .

The Properties - Form Template (New) window
opens. Ths window is where you describe your
form to Remark Office OMR. You do this by
entering basic information about your form,
including the form template description, Page
size and Page orientation.

4. EnterHospital Stay Evaluation in the
Description box.
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Properties - Form Template (New)

Describe and define the layout of your new form template.
O Acquire page images
O Al pages must be of the same size

O Al pages must conform to the same page orientation

Description [optionall: | Hospital Stay Evaluation

Page size: US Letter -

Unit of measure:

Page orientation: Fortrait -

Capture Image...

Cancel




5. Locate the Page size area where you can tell the software the size paper your form uses.If not
already listed, slect US Letter in the Size drop-down list.

6. Locate the Orientation area and selectPortrait .
7. Click the Capture Image button to continue.

The Create Page Elements window appears. The CreatePage Elements window allows you to either
acquire an image of your form from your scanner, or acquire an image of your form from an existing
image File. EachPagein a form template is created using an image of the appropriate Pagein your
form. The image allows you to see the form so that you can easily teach Remark Office OMR how to
read it.

To obtain a form template image

As previously mentioned, there are two ways to acquire an image for a form template Page Images
can be acquired by scanning to create a new imageFile or by opening an existing image File. We will
be acquiring our image fro m a pre-scanned image File stored on your computer.

1. Click the Read Images button in the
Image Collection Method area.

2. Click the Browse button. The Select
Image File window opens.

3. Select the Tutorial 2 3 Hospital Stay
Survey tif File from the Tutorial 2 folder of
your Remark Office OMR installation
directory (e.g.,\My Documents\Remark
Office OMR\Tutorials\Tutorial 2) and then
click the Open button .

Once an image is acquired by opening an
existing image File, the Template Editor displays a thumbnail of the image for your approval.

4. When a thumbnail image of your form appears, click the OK button to accept the image.

Once the thumbnail image is accepted, the Template Editor opens the new form template where you
can begin to define the regions. You see a tree view (item list) on the left and an image representation
of your form on the right.

To define form template regions

The purpose behind making a form template is to tell the software where to locate the information on
your specific form and how to un derstand your specific data requirements. The following table lists
the six regions on the Hospital Stay Evaluation form and their corresponding region types:
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